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SOMA NETWORKS INC. ENDUSER PRODUCT LICENSE AGREEMENT

THE OUTDOOR SOMAPORT™ SUBSCRIBER STATION AND PROVIDED SOFTWARE CON-
TAIN CERTAIN COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL OF SOMA
NETWORKS, INC. OR LICENSED TO SOMA NETWORKS, INC., THE USE OF WHICH IS SUB-
JECT TO THIS AGREEMENT. BY: (A) SIGNING AN AGREEMENT FOR SERVICE WITH YOUR
SERVICE PROVIDER; (B) OPENING THE SEALED ENVELOPE CONTAINING THE OUTDOOR
SOMAPORT; OR (C) USING THE OUTDOOR SOMAPORT, YOU ASSENT TO AND ACCEPT
THIS ENDUSER PRODUCT LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH ALL THE
TERMS OF THIS AGREEMENT YOU MUST RETURN THIS PRODUCT (WITH THE ENVE-
LOPE STILL SEALED), ALL MANUALS AND DOCUMENTATION, ANY SOFTWARE PACKAGES
PROVIDED WITH THE SOMAPORT AND PROOF OF PAYMENT TO THE PLACE YOU
OBTAINED THEM FOR A FULL REFUND WITHIN THIRTY (30) DAYS OF FIRST ACQUIRING
THE OUTDOOR SOMAPORT, OTHERWISE YOU ARE DEEMED TO HAVE ACCEPTED AND
AGREED TO THESE TERMS AND CONDITIONS. UNAUTHORIZED REPRODUCTION, DIS-
TRIBUTION, DECOMPILATION OR OTHER REVERSE ENGINEERING OF THIS PRODUCT
INCLUDING ITS HARDWARE AND/OR SOFTWARE, OR ANY PORTION OF IT, IS PROHIB-
ITED AND MAY RESULT IN SEVERE CIVIL AND CRIMINAL PENALTIES, AND WILL BE PROS-
ECUTED TO THE MAXIMUM EXTENT POSSIBLE UNDER THE LAW.

1. GRANT OF LICENSE: Subject to the terms of this Enduser Product License Agreement (the "Agree-
ment"), SOMA Networks, Inc. ("SOMA") grants you (the "Licensee") a non-sub-licensable, non-exclusive
right ("License") to use the Product. "Product" means, collectively, the Software and the provided hardware,
and specifically the Outdoor SOMAport™ subscriber station and its accessories, if any, together with docu-
mentation provided to you by SOMA or your service provider. "Software" means, collectively, the version of
the SOMA software program in object code format and all updates to that program distributed to you by
SOMA, directly or indirectly, by any means and includes any firmware provided to you with the Product.
You have no right, unless otherwise explicitly permitted, to receive any source code or design documentation
relating to the Product. SOMA retains ownership of all Software copies. The Software and this License is
only provided to you to be used in conjunction with the Outdoor SOMAport provided to you by SOMA or
your service provider when you subscribed to services that utilize the SOMA wireless air interface technology
and is not licensed to you to be used for any other purpose.

2. RESTRICTIONS: Except as reasonably required to use the Product strictly in accordance with the
License and this Agreement, you may not copy any Software. Licensee shall not (and shall not allow any
third party to): (I) decompile, disassemble, or otherwise reverse engineer or attempt to reconstruct or dis-
cover any source code or underlying ideas or algorithms or file formats or programming or interoperability
interfaces of the Product by any means whatsoever; (II) remove any Product identification, copyright or
other notices; (III) modify, incorporate into or with other software or create a derivative work of any part of
the Software or Product; or (IV) modify or otherwise alter the operation of the Product. Various compo-
nents, functions, routines and/or portions of the Product may be protected by Intellectual Property Rights
("IPR") including, but not limited to, designs, copyrights, trade secrets and one or more patents or pending
patent applications. Licensee is licensed under such IPR, if any, only to the extent that such a license is
required by the licensee to operate the Product in the manner intended by SOMA. No other rights are
granted under such IPR and no right to repair or replace the Product is intended or provided and specifically,
no right of reconstruction, substitution or repair is provided.
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3. TERMINATION: This License is effective until terminated. This License will terminate automatically if
you fail to cure any material breach, as determined at the sole discretion of SOMA, of this Agreement within
thirty (30) days after such breach first occurs (or immediately in the case of a breach of §2). Upon termina-
tion, you shall immediately cease all use of the Product and return all of the Product including Software,
hardware, manuals, documentation of any kind accompanying Product to the place where you first obtained
such Product or such other location as may be designated from time to time. Except for this License and
except as otherwise expressly provided herein, the terms of the Agreement shall survive termination.

4. WARRANTY DISCLAIMER: THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY
OF ANY KIND INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. FURTHER,
SOMA DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARD-
ING THE USE, OR THE RESULTS OF THE USE, OF THE PRODUCT OR WRITTEN MATERI-
ALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. YOUR
SERVICE PROVIDER MAY PROVIDE FURTHER WARRANTY COVERAGE FOR YOU.

5. LIMITATION ON REMEDIES AND DAMAGES: SOMA SHALL NOT BE RESPONSIBLE OR
LIABLE UNDER ANY CIRCUMSTANCE WITH RESPECT TO ANY SUBJECT MATTER OF THIS
ENDUSER PRODUCT LICENSE AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE,
STRICT LIABILITY OR OTHER THEORY: (A) FOR LOSS OR INACCURACY OF RECORDS OR
DATA OR (EXCEPT FOR RETURN OF AMOUNTS PAID TO SOMA THEREFOR) COST OF
PROCUREMENT OF SUBSTITUTE GOODS, SERVICES OR TECHNOLOGY, (B) FOR ANY SPE-
CIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT
LIMITED TO, LOSS OF PROFITS, LOSS OF SAVINGS, (C) THIRD-PARTY CLAIMS AGAINST
YOU FOR DAMAGES, OR (D) FOR ANY MATTER BEYOND THE REASONABLE CONTROL OF
SOMA EVEN IF SOMA AND / OR ITS SUPPLIERS IS/ARE INFORMED OF THEIR RESPONSIBIL-
ITY. SOME JURISDICTIONS DO NOT ALLOW FOR THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLU-
SION MAY NOT APPLY TO YOU.

6. UPDATES TO SOFTWARE and TRANSMISSION OF PERSONAL DATA: You consent to receive
and employ updates to Software, without requiring further notice to you, that may occur from time to time,
as may be necessary, as determined at the sole discretion of SOMA and/or your service provider, for the use
of Product by you and for the efficient utilization of services as may be purchased or subscribed to by you
from your service provider. You also agree to the application of the terms of this Agreement to any and all
such updates. You accept and acknowledge that Software shall be able to transmit such data as is authorized
by your service provider in order to allow for the utilization of services subscribed or purchased by you in
order to allow for the billing of such services or as may be necessary by law.

7. MISCELLANEOUS: This Agreement and the License provided by this Agreement are not assignable or
transferable by you without the prior written consent of SOMA. Any attempt by you to do so shall be void
and void this License. Any notice, report, approval or consent required or permitted hereunder shall be in
writing. If any provision of this Agreement shall be adjudged by any court of competent jurisdiction to be
unenforceable or invalid, that provision shall be limited or eliminated to the minimum extent necessary so
this Agreement shall otherwise remain in full force and effect and enforceable. This Agreement shall be con-
strued pursuant to the laws of the United States of America and the State of California and without regard to
conflicts of laws principles thereof. If successful in any action to enforce this Agreement, SOMA shall be
entitled to recover costs and expenses including, without limitation, attorney's fees. The parties agree that a
material breach of this Agreement would cause irreparable injury to SOMA, or its suppliers, for which mon-
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etary damages would be an adequate equitable relief and SOMA shall be entitled to any other remedies it
may have available hereunder or at law. Both parties agree that this Agreement is the complete and exclusive
statement of mutual understanding of the parties and supersedes and cancels all previous written and oral
agreements and communications relating to the subject matter of this Agreement. BOTH YOU AND
SOMA AGREE AND ACKNOWLEDGE THAT SOMA RESERVES THE RIGHT TO AMEND THE
TERMS AND CONDITIONS OF THIS AGREEMENT WITHOUT FURTHER NOTICE TO YOU
OTHER THAN PROVIDING TO YOU THE AMENDED TERMS AND CONDITIONS OF THIS
AGREEMENT. IF YOU DO NOT ACCEPT THE AMENDED TERMS AND CONDITIONS AS
PROVIDED TO YOU BY SOMA, THIS LICENSE SHALL TERMINATE IMMEDIATELY. ALL USE
OF THE SOFTWARE AND ANY SERVICES SUPPORTED BY THE PRODUCT AND SOFTWARE
MAY CEASE OR BE CAUSED TO BE CEASED WITHOUT ANY LIABILITY TO YOU BY SOMA
AND YOU SHALL RETURN ALL PRODUCT HARDWARE, MANUALS, DOCUMENTATION OF
ANY KIND ACCOMPANYING SOFTWARE TO THE PLACE WHERE YOU FIRST OBTAINED
SUCH HARDWARE, MANUALS, DOCUMENTATION AND SOFTWARE
7
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PREFACE
Conventions
This section outlines the conventions used in this guide.

Measurement Conventions
Measurements in this guide are expressed according to the Systeme International 
d’Unites standards for metric units and abbreviation. Equivalent Imperial 
measurements (used in the United States) are provided in parentheses, except when 
Imperial is the international standard.

Bits and bytes are not abbreviated, though their prefixes are; for example, "kbits" for 
kilobits, "Gbytes" for gigabytes.

Trademark Identification
The Outdoor SOMAport™ subscriber device, a trademark of SOMA Networks Inc., 
is referred to without notation in the rest of this document.
9



P r e f a c e
Alerts used in this guide

!
WARNING: Where you see this symbol and the
WARNING heading, strictly follow the instructions to avoid
personal injury or damage to the product.

WARNING: Where you see this symbol and the WARNING
heading, strictly follow the instructions to avoid electric
shock.
10



P r e f a c e
Important Safety Instructions
For your safety and protection, read this entire guide before you attempt to install 
the SOMAport. In particular, read this safety section carefully. Keep this safety 
information where you can refer to it if necessary.

Read instructions – Read and follow all of the safety and operating instructions 
before operating the SOMAport.

Retain instructions – Retain the safety and operating instructions for future ref-
erence.

Follow instructions – Follow all operating instructions.

Heed warnings – Adhere to all warnings on the SOMAport and in the operating 
instructions.

Power sources – Use only the type of power source indicated on the label. If you 
are not sure of the type of power supplied to your home, consult your product 
dealer or local power company.

Grounding or polarization – The plug for the power cord on the  SOMAport 
fits into the power outlet only one way. If you are unable to insert the plug fully 
into the outlet, contact your electrician to replace your outlet. To prevent electric 
shock, do not use this plug with an extension cord or outlet unless you can fully 
insert the blades without blade exposure. Do not defeat the safety purpose of this 
plug.

Power-cord protection – Route power-supply cords so that they are not likely to 
be walked on or pinched by items placed upon or against them. Watch for wear in 
the cord at the plug and socket.

Attachments – Do not use attachments with the SOMAport that have not been 
recommended in this guide as they may cause hazards.

Power lines – Locate the outdoor unit of the SOMAport more than 6 m (20 feet) 
from overhead power lines, electric lights, or power circuits. When installing the 

WARNING: One milliampere of current flowing through
your body can kill you. Voltage as low as 15 volts can kill
under the right conditions. Treat energized equipment with
respect.
11



P r e f a c e
outdoor unit, do not touch (or allow the outdoor unit or any cabling or ladder to 
tough) power lines, electric lights, and power circuits, as contact with them may 
be fatal. If any part of the outdoor unit comes into contact with a power line, call 
your local power company. Do not try to remove it yourself.

Weather conditions – Do not install the outdoor unit of the SOMAport while it 
is raining, if there is threat of lightning, or if winds are over 40 km/h (25 miles per 
hour).

In addition to the safety instructions above, follow these guidelines when installing 
the SOMAport:
12



P r e f a c e
 Important Notice about Installation
An improperly installed SOMAport may cause serious damage to you and/or your 
property may even cause fatal injuries. The SOMAport Installation Guide has been 
developed and is intended for those individuals with experience in performing 
various installation tasks involving outdoor telecommunication devices. It is strongly 
recommended that the SOMAport be installed by those individuals who have 
experience, at a minimum, with the following tasks:

Familiarity and ability to use a power drill and associated tools and devices to 
safely drill holes into the exterior and interior structures of a house

Familiarity and ability to determine with a high degree of accuracy and 
precision the location of support studs, water pipes, electrical wiring, or 
heating, air conditioning, or gas lines or conduits in the structure near where 
holes are being drilled in the house

Familiarity and ability to route CAT5 cable through walls, under floors and/
or interior walls.

Before installing the SOMAport, you are advised to check the zoning codes, 
covenants and community restrictions that may be applicable in your area. Certain 
areas may prohibit the installation of devices such as the SOMAport. SOMA 
Networks, Inc. will not accept and is not responsible or liable for any damages or 
injuries that may result from the installation of the SOMAport by you. If you are 
not in agreement with this notice, or do not have the experience necessary to install 
the SOMAport, please contact your telecommunications service provider for further 
instructions with regard to the proper installation of the SOMAport.

!
WARNING: The outdoor unit must not be used indoors. It
must be mounted on a permanent outdoor structure.

!
WARNING: Do not connect any third-party devices to the
outdoor unit, CAT5 cable, or indoor unit. Otherwise,
damage may occur.
13



P r e f a c e
Maintenance and servicing
Cleaning – Unplug the indoor unit from the wall outlet before cleaning. Do not 
use liquid cleaners or aerosol cleanser. Use a dry cloth for cleaning.

Servicing – Do not attempt to service the outdoor unit of the SOMAport your-
self. Opening or removing covers may expose you to dangerous voltage or other 
hazards and may void the warranty. There are no user-serviceable parts inside. 
Refer all servicing to qualified service personnel.

Replacement parts – When replacement parts are required, have the technician 
verify that the replacements being used have the same safety characteristics as the 
original parts. Use of replacement parts specified by the product manufacturer 
can prevent fire, electric shock, other hazards.

Conditions requiring service – Unplug the indoor unit from the wall outlet and 
refer servicing to qualified service personnel under the following conditions:

The power supply or cord is damaged.

Liquid has been spilled on the indoor unit or it has been exposed to water.

An object has fallen into the SOMAport.

The SOMAport does not function normally even though you have adhered 
to the operating instructions and have made adjustments to only those 
controls covered by the operating instructions.

The SOMAport has been dropped and a change in performance has 
occurred.

The SOMAport exhibits a distinct change in performance.
14



P r e f a c e
REGULATORY NOTICES

The Outdoor SOMAport has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, you can try to correct the 
interference by:

Relocating the SOMAport

Increasing the distance between the SOMAport and the device experiencing 
the interference

Connecting the equipment to an outlet on a circuit different from that to 
which the SOMAport is connected

Declaration of Conformity

SOMA Networks, Inc.,
185 Berry Street, Suite 4600

San Francisco, CA 94107 U.S.A.
(415) 882-6500

declares under our sole responsibility that the product
Outdoor SOMAport

complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful

interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

ATTENTION: Changes or modifications not expressly approved
by SOMA Networks for compliance could void the user’s authority
to operate the equipment.
15
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INTRODUCTION
This chapter provides an overview of the Outdoor SOMAport. 

Contents
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I n t r o d u c t i o n
OVERVIEW

The Outdoor SOMAport™ subscriber terminal provides high-speed Internet access 
and telephone service. The SOMAport works like a cell phone, in that it 
communicates with your service provider’s network over the air and does not require 
a special wire connection.

The SOMAport consists of two parts: an outdoor unit and an indoor unit. After 
installing the outdoor unit, simply plug-in the indoor unit and connect it to your 
computer using the provided Ethernet cable. The SOMAport will automatically 
connect to your service provider and you can setup your account using a Web 
browser.

If you are using your SOMAport to provide telephone service, you can connect 
ordinary telephones to it.

Internet service
The SOMAport provides a high-speed, "always on" internet connection, which 
means you can be connected to the Internet and still use your telephone. The 
SOMAport is designed to be left on – it should not be turned off when not in use.

Telephone service
The telephone service provided by the SOMAport is independent and separate from 
your phone service. Wireless services may differ from your traditional wired services. 
Consult with your wireless service provider for details.
18



I n t r o d u c t i o n
SYSTEM COMPONENTS

Outdoor Unit: The outdoor unit is a ruggedized box, typically pipe-mounted, that 
contains a radio modem and an internal antenna. It uses a single cable (CAT5) that 
transmits data, telephone, and power to and from the indoor unit.

Indoor Unit: The indoor unit is placed inside subscriber’s residence and connects to 
the subscriber’s computer and telephones. The indoor unit also functions as an AC 
adapter for the outdoor unit.
19



I n t r o d u c t i o n
THE INDOOR UNIT

The ports and jacks used to connect computers and telephones to the indoor unit are 
shown below:

Part Description

Ethernet port Use this port with the supplied Ethernet 
cable to connect the indoor unit to a 
computer or hub.

Telephone jacks Use these jacks to connect telephones 
to the indoor unit. The SOMAport can 
provide up to two independent 
telephone lines, depending on your 
service provider.

!
Use ODU I/F port to attach the CAT5 cable that connects the 
indoor unit to the outdoor unit. DO NOT connect the cable to 
any of the other jacks or ports.
20



I n t r o d u c t i o n
Status Light
The status light indicates whether or not the SOMAport is powered on and 
operating normally.

Network Light
The network light indicates if the SOMAport has located a base station.

State Description

Off The SOMAport is not receiving power.

Amber The SOMAport is booting and running its internal 
diagnostics.

Flashing Amber The SOMAport is upgrading its software

Green The SOMAport is powered and operating normally.

Red An error occurred. The SOMAport is not currently 
functional.

!
DO NOT unplug the SOMAport when the Status light is flashing 
amber.

Status Description

Off The SOMAport is not receiving power.

Amber The SOMAport is attempting to locate a base station.

Flashing Amber The SOMAport cannot locate a base station.

Flashing Green The SOMAport has located a base station and is 
attempting to establish a connection.

Green The SOMAport has located a base station and has 
established.

Red An error occurred. The SOMAport is not currently 
functional.
21



I n t r o d u c t i o n
ANTENNA

The outdoor unit of the SOMAport communicates with a cellular tower operated by 
your wireless service provider. The outdoor unit contains an internal antenna that 
automatically steers itself toward the best signal when you plug in the SOMAport. It 
also periodically checks to see if the current antenna direction is optimal and adjusts 
automatically if required.

!
WARNING: While this device is in operation, a separation
distance of at least 20 centimeters (8 inches) must be
maintained between the radiating antenna and any person
exposed to the transmitter in order to meet the FCC RF
exposure guidelines. No change to the antenna or device is
permitted. Doing so may result in the installed system
exceeding RF exposure requirements. This device must
not be co-located or operating in conjunction with any other
antenna or radio transmitter. Installers and end users must
follow the installation instructions provided in this guide.
22



CONNECTING THE
INDOOR UNIT
This chapter describes how to connect computer and telephone equipment to the 
indoor unit.

Contents

Connecting the Power Supply and Powering on the Indoor Unit ........................  24
Connecting a Computer via Ethernet ..................................................................  25
Connecting Telephones to the Indoor Unit ..........................................................  26
Activating Service ................................................................................................  30
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C o n n e c t i n g
the  indoor  un i t
CONNECTING THE POWER SUPPLY
AND POWERING ON THE INDOOR UNIT

The indoor unit does not have a power switch. You turn on the indoor unit by 
plugging it into a power outlet, and turn it off by unplugging it. When you plug in 
the indoor unit, it starts, connects to your service provider’s network, and establishes 
a connection.

To install the power supply and power on the indoor unit
1 Insert the DC plug into the  power jack of the indoor unit.

2 Insert the socket end of the power cord into the power supply’s 
receptacle. 

3 Insert the plug end of the power cord into a three-prong grounded 
power outlet. The indoor unit powers on when you plug it in. There 
is no power button. The light on the power supply turns when it is 
receiving power. 

4 The SOMAport takes up to five minutes to start, acquire a radio 
signal, and connect to the network.

NOTE: If you ever need to disconnect the power supply, 
disconnect the power cord from the power outlet first. Then 
unplug the connector from the back of the indoor unit.

!
WARNING: Use only the power supply and power cord
that came with the indoor unit. Using another power supply
may damage your equipment and poses the risk of shock
or electrocution.
24



C o n n e c t i n g
the  indoor  un i t
CONNECTING A COMPUTER
VIA ETHERNET

Use the supplied Ethernet cable to connect your computer to the indoor unit.

NOTE: If your computer does not have an Ethernet port, you 
will need to purchase an Ethernet card or an Ethernet-to-USB 
adapter. Contact your service provider for information about 
supported hardware.

To connect a computer via Ethernet
1 Insert one end of the supplied Ethernet cable into the Ethernet port 

on the indoor unit.

2 Insert the other end of the cable into the Ethernet port on your 
computer.
25



C o n n e c t i n g
the  indoor  un i t
CONNECTING TELEPHONES TO
THE INDOOR UNIT

In order to use a telephone with your SOMAport, you will need to subscribe to your 
service provider’s telephone service during service activation.

If telephone service is not available in your area or if you do not want to use 
telephones with your SOMAport, skip to "Activating Service" on page 30.

Telephone Jacks
There are two telephone jacks on the indoor unit, one for line 1 (left) and the other 
for line 2 (right).

How you connect telephones to the indoor unit depends on three things.

The number of lines you subscribe to (one or two)

The number of telephones you connect to the indoor unit

The type of telephones you connect (one-line or two-line telephones)

Lines Connecting One 
Telephone

Connecting Two Telephones

One Use the line 1 (left) jack. 
See "To connect a single 
telephone" on page 28.

Insert a duplex adapter into the line 1 
(left) jack and then connect both 
telephones to the adapter. See "To 
connect two telephones (when you 
have one line)” on page 28.

Two Use the line 1 (left) jack. 
See "To connect a single 
telephone" on page 28.

Connect telephones to both jacks. 
See "To connect two telephones 
(When you have two lines)" on page 
28.
26



C o n n e c t i n g
the  indoor  un i t
To connect a single telephone to the indoor unit
1 Insert the free end of the telephone cable into the line 1 (left) jack 

on the indoor unit.

NOTE: To connect a two-line telephone, you must subscribe to 
two lines.
27



C o n n e c t i n g
the  indoor  un i t
To connect two telephones (when you have two lines)
1 Connect the cable of the telephone you want serviced by line 1 to 

the line 1 (left) jack on the indoor unit.

2 Connect the cable of the telephone you want serviced by line 2 to 
line 2 (right) jack on the indoor unit.

NOTE: If you have a two-line telephone, connect it to the line 1 
(left) jack.

To connect two telephone (when you have one line)
1 Insert a dual-jack extension cord or adapter into the line 1 (left) 

jack of the indoor unit.

2 Insert the free end of one telephone cable into one of the jacks on 
the adapter.

3 Insert the free end of the second telephone cable into the other 
jack on the adapter.
28



C o n n e c t i n g
the  indoor  un i t
To test your SOMAport telephone service
Pick up the receiver and listen for dial tone.

If you hear a standard dial tone, the SOMAport is connected to 
your service provider’s network. You may have to activate full 
service if your service provider has not done so already. See 
"Activating Service" on page 30.

If you hear a series of tones, the SOMAport is still starting. Hang 
up, and listen again in a few minutes.

If you hear silence, see "Finding Causes of Telephone Problems"  
on page 38.
29



C o n n e c t i n g
the  indoor  un i t
ACTIVATING SERVICE

After the SOMAport powers on, it will be in one of two service modes:

Restricted access – Your SOMAport remains in this mode until your 
account is activated by your service provider. You can use the SOMAport 
only to contact your service provider to activate full service, either by 
telephone or through the service provider’s Web site. You cannot receive 
telephone calls in this module, although you can place a call to an emergency 
service (for example, 911 in North America).

Full-service access – You can browse any site on the Internet, receive 
telephone calls, and place calls to any telephone number.

To activate full service
1 Restart your computer while it is connected to the powered-on 

SOMAport.

2 Launch a Web browser.

3 Direct your browser to a known valid Internet address (such as 
www.google.com).

If the page opens, full service has already been activated and 
you can begin using your SOMAport for Internet service.

If you are redirected to your service provider’s Web page, 
complete the signup procedure on the Web site to activate full 
service.

If you can not open any Web pages at all, see "Finding 
Causes of Computer Problems" on page 36.

NOTE: If you subscribe only to telephone service, activate full 
service by calling your service provider’s assistance center.
30



CONNECTING MULTIPLE
COMPUTERS
This chapter explains how to install the Outdoor SOMAport as an Internet gateway 
for a local area network. Follow the procedures in this chapter if you want to connect 
multiple computers.

Contents

Overview .............................................................................................................  32
Using an Ethernet Hub ........................................................................................  33
Using an Internet Router .....................................................................................  34
31



C o n n e c t i n g
multiple computers
OVERVIEW

A hub, switch, or router is required in order to share the Internet connection with 
multiple computers. The Outdoor SOMAport functions as a DHCP server (it 
automatically assigns IP addresses to devices attached to it) and will work with most 
consumer home network devices.

The connection procedure differs slightly depending on the type of your home 
network device.

When using a hub or switch, see "Using an Ethernet Hub" on page 33.

When using an Internet router see "Using an Internet Router" on page 34.
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C o n n e c t i n g
multiple computers
USING AN ETHERNET HUB

An Ethernet hub or switch (referred to generically in this section as a "hub") can be 
used to have multiple computers share an Internet connection from a single  
SOMAport.

NOTE: Each computer connected to the hub requires an IP 
address assigned to it by your service provider. Contact your 
service provider for information about provisioning an account 
that can use several IP addresses.

To use an Ethernet hub with the SOMAport
1 Choose a location and power on the indoor unit, as described in 

chapter "Connecting the Power Supply and Powering on the 
Indoor Unit” on page 24.

2 Wait for the SOMAport to find a base station.

3 Connect the indoor unit to the hub:

i Insert one end of a straight-through Ethernet cable into the 
Ethernet port on the indoor unit.

ii Insert the other end of the cable into an uplink port (sometimes 
labeled as a WAN or Internet port) on the hub.

NOTE: If the hub does not have an uplink port, you may 
connect to the indoor unit using an Ethernet port (which may be 
labeled as a switched, LAN, or numbered port) on the hub. 
However, you must obtain and use a crossover Ethernet cable 
(not shipped with the SOMAport) to make this connection.

4 Power on the hub.

5 Connect each computer to an Ethernet port on the hub.

6 Reboot each computer.
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C o n n e c t i n g
multiple computers
USING AN INTERNET ROUTER

An Internet router, supporting either Ethernet or WiFi (802.11) connections, can be 
used to have multiple computers share an Internet connection from a single 
SOMAport.

To use an Internet router with the SOMAport
1 Choose a location and power on the indoor unit, as described in 

chapter "Installing the Indoor Unit.”

2 Wait for the SOMAport to find a base station.

3 Power on the router.

4 If necessary, configure the router to use DHCP when obtaining an 
external IP address. See the documentation for your router for 
specific configuration Information.

5 Connect the SOMAport to the router:

i Insert one end of a straight-through Ethernet cable into the 
Ethernet port on the indoor unit.

ii Insert the other end of the cable into an uplink port (sometimes 
labeled as a WAN or Internet port) on the router.

6 Connect each computer to the Internet router. See the 
documentation for your router for information.
34



TROUBLESHOOTING
This chapter describes the problems the SOMAport may exhibit, the possible causes 
of those problems, and the actions you should take to fix them.

Contents
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Troubleshooting
FINDING CAUSES OF
COMPUTER PROBLEMS

Look up the problem you are experiencing and follow the suggested actions. If the 
recommended actions do not fix the problem, contact your service provider.

Problem Possible causes Action

You cannot 
connect to 
the Internet

Network settings for an 
Ethernet connection are 
incorrect.

See "Ethernet Network 
settings are Incorrect" on page 
49.

Signal has been dropped. Unplug the indoor unit and 
plug it back in again.

The SOMAport is not 
receiving power.

See "The SOMAport is Not 
Receiving Power" on page 44.

The SOMAport 
experienced a fault 
condition during startup.

See "There is a Fault 
Condition" on page 43.

No connection between the 
computer and the indoor 
unit.

See "There is a Problem with 
the Ethernet Cabling" on page 
45.

You are using Internet 
Explorer and the LAN 
settings are not properly 
configured.

See "Internet Explorer LAN 
Settings are Incorrect" on 
page 48.

Signal is weak. See "The Signal is Weak" on 
page 41

It takes a 
long time to 
open a Web 
page

Internet congestion. Try again.

Signal is weak. See "The Signal is Weak" on 
page 41.

Cable connecting the 
computer to the indoor unit 
is damaged.

Replace the cable.
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It takes a 
long time to 
open a Web 
page

Your Ethernet interface is 
in full-duplex mode. (This 
applies only if your indoor 
unit is directly connected to 
the Ethernet port on your 
computer, rather than 
through a hub.)

Use the appropriate system 
control to change the duplex 
setting of your Ethernet port to 
half-duplex. Refer to the 
documentation for your 
operating system.

Making a 
wireless 
Internet 
connection is 
prevented by 
old dial-up 
default

Computer is set up to 
connect to the Internet via 
dial-up by default.

See "The Computer Uses an 
Old Dial-UP Connection" on 
page 46.

You cannot 
send Email

SMTP server associated 
with your existing email 
account is not accessible.

Use a Web account, such as 
yahoo, for sending and 
receiving messages.

Problem Possible causes Action
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FINDING CAUSES OF
TELEPHONE PROBLEMS

Look up the problem you are experiencing and follow the suggested actions. If the 
recommended actions do not fix the problem, call your service provider.

Problem Possible causes Action

Irregular dial 
tone

If you hear a series of tones 
(not a regular dial tone) 
before you attempt a call, 
the SOMAport has not yet 
acquired a signal.

Wait a few minutes and try 
again.

No dial tone If you hear a "fast busy" 
tone after you attempt to 
dial a number, you have not 
yet acquired a signal.

Activate full service as 
described in "Activating 
Service" on page 30.

If your telephone is 
connected to line 2 and you 
hear silence before dialing 
a call, you are in restricted 
mode.

Activate full service as 
described in "Activate Service" 
on page 30.

Cable connections are not 
secure.

Make sure the telephone cable 
is securely connected to the 
indoor unit and the telephone.

Telephone cable is inserted 
into the indoor unit’s  
Ethernet port

Make sure that the telephone 
is connected to a telephone 
jack.

Telephone is broken. Try a telephone that is known 
to work. If you were using a 
cordless telephone, try using a 
corded one.

The SOMAport 
experienced a fault 
condition during startup.

See "There is a Fault 
Condition" on page 43.

The SOMAport is not 
receiving power.

See "The SOMAport is not 
Receiving Power" on page 44.
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No dial tone Signal is weak. See "The Signal is Weak" on 
page 41.

Voice quality 
is poor

Signal is weak. See "The Signal is Weak" on 
page 41.

Telephone is broken. Try a telephone that is known 
to work. If you were using a 
cordless telephone, try using a 
corded one.

Calls are 
dropped

Signal is weak. See "The Signal is Weak" on 
page 41.

Problem Possible causes Action
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Troubleshooting
FINDING CAUSES OF
OUTDOOR UNIT PROBLEMS

If you experience any of the following problems, follow the suggested actions.

Problem Corrective Actions

The cable connections 
are poor

Secure the cable connections.

The signal is weak Reposition the outdoor unit following the guidelines 
on page 79.

The total length of the 
CAT5 cable from the 
outdoor unit to your 
personal computer is 
more than 50 m

Check the connections and make sure they are 
secure. Poor connections may be reported due to 
excessive cable length. Reposition the outdoor unit 
or the indoor unit to reduce the amount of cable 
required.
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THE SIGNAL IS WEAK

The signal to your SOMAport may be weak if you are having any of the following 
problems:

Telephone voice quality is poor or calls are dropped.

It takes a long time to open a Web page.

You cannot browse the Internet at all.

To improve reception quality
If you are experiencing an outgoing performance problem, try the following 
steps:

1 Make sure you have located the outdoor unit according to the 
guidelines listed in "Installation guidelines and requirements" on 
page 79.

2 See if a nearby appliance is having an effect on the signal. Do the 
following for each appliance, testing one appliance at a time:

i Turn off the appliance.
ii While the appliance is off, check the signal strength indicator 

to see if the signal improves.
If there is an improvement, reposition either the appliance 
or the outdoor unit so that they are further apart.

If there is no improvement, turn the appliance back on and 
try another appliance.

3 If you cannot improve reception in the outdoor unit’s current 
location, try moving it to another location that meets the guidelines 
on page 79.
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Persistent Reception Difficulties
Reception can be temporarily affected by severe weather conditions such as heavy 
storms, ice, or strong winds. Problems may persist in the absence of these conditions 
if:

There are obstructions – tall buildings, trees, or mountains – between your 
outdoor unit and the nearest communications tower.

Your outdoor unit is located at the outer limit of the coverage area.

Contact your service provider if you experience persistent signal reception 
difficulties.
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THERE IS A FAULT CONDITION

This section describes how to restart the indoor unit. If you cannot solve a problem 
with any of the procedures above, try restarting.

To restart indoor unit
1 Unplug the indoor unit and leave it off for at least 10 seconds.

2 Plug in the indoor unit.

Wait until the status light indicates that the SOMAport is receiving 
a radio signal. If the problem is not solved, please call your service 
provider.
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THE SOMAPORT IS
NOT RECEIVING POWER

If the light on the power supply of the indoor unit is off, the SOMAport is not 
receiving power. Try each of the actions in the following procedure until you locate 
the source of the problem.

To check the power
1 Make sure the power cord which connects the power supply to the 

wall outlet is securely connected to the power supply and the wall 
outlet.

2 Make sure the power cord which connects the power supply to the 
indoor unit is securely connected to the power jack of the indoor 
unit.

3 Make sure the CAT5 cable which connects the indoor unit to the 
outdoor unit is securely connected.

4 Make sure the wall receptacle is working by plugging in an 
appliance which you know works.

5 Check the circuit breaker.

6 If you cannot find the source of the problem, call your service 
provider.
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THERE IS A PROBLEM WITH
THE ETHERNET CABLING

If there is a problem with the physical connection between the indoor unit and 
either your computer or hub, you will not be able to browse the Internet.

To check Ethernet cabling
1 Make sure the cable connectors are firmly inserted in the 

appropriate Ethernet ports on the indoor unit and computer or hub.

2 Make sure you are using the correct type of cable:

3 Make sure the length of the cable does not exceed 50 meters (167 
feet). See page 81.  

4 If none of the previous steps solves the problem, replace the 
cable.

NOTE: You can replace the cable while the SOMAport is on.

Configuration Cable Type Provided

Ethernet port of a computer Straight-through Yes

Uplink port of a hub Straight-through Yes

Ethernet port of a hub Crossover No
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Troubleshooting
THE COMPUTER USES
AN OLD DIAL-UP CONNECTIONS

If you have switched from a dial-up Internet service you may still be prompted to 
connect to the Internet using the old dial-up connection. If this is the case, follow 
this procedure to ensure that your dial-up connection is not automatically activated 
whenever you attempt the Internet connection.

To disable the automatic dial-up connection in Windows
1 Open the Control Panel.

In Windows XP – Choose Start → Control Panel.

In all other versions of Windows – Choose Start → 
Settings → Control Panel.

2 Double-click the Internet Options icon.

The Internet Properties window opens.

3 Click the Connections tab.

4 Enable the Never dial a connection checkbox. 

5 Click OK.

NOTE: If you are still unable to display a Web page, check your 
browser to make sure it is in online mode.

To disable the automatic dial-up connection in Mac OS 8 
and 9

1 Click the Apple icon and choose Control Panels.

2 Click Remote Access.

3 Click Options.

4 Click the Protocol tab.

5 Make sure the Connect automatically when starting TCP/IP 
applications box is disabled.

6 Click OK.

7 Choose File → Quit.

8 Click Save when prompted to save the current configuration.
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To disable the automatic dial-up connection in Mac OS X
1 Click the Apple icon and choose System Preferences.

2 Click the Network icon.

3 Click Show.

4 Select Network Port Configurations from the pull-down list.

5 Disable the On checkbox for the dial-up modem.

6 Click Apply Now.
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Troubleshooting
INTERNET EXPLORER LAN SETTINGS
ARE INCORRECT

If you are using Internet Explorer as your Web browser, make sure it is configured to 
automatically detect LAN settings. If this default setting has been disabled, you will 
not be able to connect to the Internet.

To check Internet Explorer settings
1 Open Internet Explorer.

2 Choose Tools → Internet Options.

The Internet Options window opens.

3 Click the Connections tab.

4 Click LAN Settings.

The Local Area Network (LAN) Settings window opens.

5 Make sure the Automatically detect settings checkbox is 
enabled.

6 Click OK.

7 Click OK on the Internet Options window.

8 Close Internet Explorer.
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ETHERNET NETWORK SETTINGS
ARE INCORRECT

If you could not establish an Internet connection after connecting your computer to 
the indoor unit via Ethernet, but your physical connection seems to be intact, your 
computer’s Ethernet network settings may need to be changed.

Use the procedure in this section appropriate to your operating system to 
reconfigure Ethernet network settings. You may be prompted to insert the 
installation CD for your operating system, and you may need to reboot your 
computer after changing the settings before you can successfully connect to the 
Internet.

To change network settings in Windows 95
1 Choose Start → Settings → Control Panel.

2 Double-click the Network icon.

The Network window opens to the Configuration tab.

3 Select TCP/IP. 

If multiple TCP/IP connections are listed, select the one that 
contains "Ethernet", "NIC", or "10/100 MB" in its name, go to 
step 5. 

If TCP/IP is not listed, go to step 4.

4 Install TCP/IP:

i Click Add.
The Select Network Component Type window opens.

ii Select Protocol from the list.
iii Click Add.

The Select Network Protocol window opens.
iv Select Microsoft from the Manufactures list.
v Select TCP/IP from the Network Protocols list.
vi Click OK.
vii Insert the Windows 95 CD or reboot the computer if prompted 

to do so.
viii If the PC reboots, repeat steps 1 to 3, then go to step 5.
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5 Check the TCP/IP properties:

i Click Properties.
The TCP/IP Properties window opens to the IP Address tab.

ii Make sure the Obtain an IP address automatically radio 
button is enabled.

iii Click the DNS Configuration tab.
iv Enable the Disable DNS radio button.
v Click OK on the TCP/IP Properties window.
vi Click OK on the Network window.
vii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on 
the computer connected to the indoor unit.

If your browser automatically opens to your service provider’s 
Web site, activate full service by following the sign-up 
procedure that is provided on the Web site.

If your browser does not automatically open to your service 
provider’s Web site, go to step 7.

7 Enter a valid Internet address (such as www.google.com) in the 
Address field.

If the Web page opens, full service has already been activated 
and you can begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service 
by following the sign-up procedure that is provided on the Web 
site.

If your computer attempts to connect to the Internet using an 
old dial-up connection, see "The Computer Uses an Old Dial-
Up Connection" on page 46.

If you do not get an Internet connection, see "Finding Causes 
of Computer Problems" on page 36.

To change network settings in Window 98 and ME
1 Choose Start → Settings → Control Panel.

2 Click the Network icon.

The Network window opens to the Configuration tab.

3 Select TCP/IP.
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If multiple TCP/IP connections are listed, select the one that 
contains "Ethernet", "NIC", or "10/100 MB" in its name, go to 
step 4.

If TCP/IP is not listed, install it:

i Click Add.
The Select Network Component Type window opens.

ii Select Protocol from the list.
iii Click Add.

The Select Network Protocol window opens.
iv Select Microsoft from the Manufacturers list.
v Select TCP/IP from the Network Protocols list.
vi Click OK.
vii Insert the Windows 98 or ME CD or reboot the computer if 

prompted to do so.
viii If the PC reboots, repeat steps 1 to 3.

4 Check TCP/IP properties:

i Click Properties with the correct TCP/IP connection selected.
The TCP/IP Properties window opens to the IP Address tab.

ii Make sure the Obtain an IP address automatically radio 
button is enabled.

iii Click the DNS Configuration tab.
iv Make sure the Disable DNS radio button is enabled.
v Click OK on the TCP/IP Properties window.
vi Click OK on the Network window.
vii Restart the computer if prompted to do so.

5 Check your Internet connection by launching a Web browser on 
the computer connected to the indoor unit.

If your browser automatically opens to your service provider’s 
Web site, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your browser does not automatically open to your service 
provider’s Web site, go to step 6.

6 Enter a valid Internet address (such as www.google.com) in the 
Address field and press Enter.

If the Web page opens, full service has already been activated 
and you can begin using your SOMAport for Internet service.
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If your service provider’s Web page opens, activate full service 
by following the sign-up procedure that is provided on the Web 
site.

If your computer attempts an Internet connection using an old 
dial-up connection, see "The Computer Uses an Old Dial-Up 
Connection" on page 46.

If you do not establish an Internet connection, see "Finding 
Causes of Computer Problems" on page 36.

To change network settings in Windows 2000
1 Right-click the My Network Places icon and choose Properties 

from the pull-down menu.

The Network and Dial-up Connections window opens.

2 Select the Local Area Connection icon.

If there are multiple local area connections, read the device 
name beside each icon and double-click the one that is 
associated with the Ethernet card.

If there is no icon, the Ethernet card has not been properly 
installed. Install the Ethernet card by following the 
manufacturer’s instructions, then return to this procedure.

The Local Area Connection Status window opens.

3 Click Properties.

The Local Area Connection Properties window opens.

4 Select Internet Protocol (TCP/IP).

If Internet Protocol (TCP/IP) is not listed, install it as follows:

i Click Install.
The Select Network Component Type window opens.

ii Select Protocol from the list.
iii Click Add.

The Select Network Protocol window opens.
iv Select Internet Protocol (TCP/IP).
v Click OK.
vi Insert the Windows 2000 CD or reboot the computer if 

prompted to do so.
vii If the PC reboots, repeat steps 1 to 4.
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5 Check TCP/IP properties:

i Click Properties.
ii The Internet Protocol (TCP/IP) Properties window opens to the 

General tab.
iii Make sure the Obtain an IP address automatically radio 

button is enabled.
iv Make sure the Obtain DNS server address automatically 

radio button is enabled.
v Click OK on the Internet Protocol (TCP/IP) Properties window.
vi Click OK on the Local Area Connection Properties window.
vii Click Close on the Local Area Connection Status window.
viii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on 
the computer connected to the indoor unit.

If your browser automatically opens to your service provider’s 
Web site, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your browser does not automatically open to your service 
provider’s Web site, go to step 7.

7 Enter a valid Internet address (such as www.google.com) in the 
Address field.

If the Web page opens, full service has already been activated 
and you can begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service 
by following the sign-up procedure that is provided on the Web 
site.

If your computer attempts to connect to the Internet using an 
old dial-up connection, see "The Computer Uses an Old Dial-
Up Connection" on page 46. 

If you do not get an Internet connection, see "Finding Causes 
of Computer Problems" on page 36.
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To change network settings in Windows XP
1 Choose Start → Settings → Network Connections.

The Network Connections window opens.

2 Select the Local Area Connection icon.

If there are one or more Local Area Connection icons, 
double-click the Local Area Connection icon that is associated 
with the Ethernet card.

If there is no icon, the Ethernet card has not been properly 
installed. Install the Ethernet card by following the 
manufacturer’s instructions, then return to this procedure.

The Local Area Connection Status window opens.

3 Click Properties.

The Local Area Connection Properties window opens.

4 Select Internet Protocol (TCP/IP).

If Internet Protocol (TCP/IP) is not listed, install it as follows:

i Click Install.
The Select Network Component Type window opens.

ii Select Protocol from the list.
iii Click Add.

The Select Network Protocol window opens.
iv Select Internet Protocol (TCP/IP).
v Click OK.
vi Insert the Windows XP CD or reboot the computer if prompted 

to do so.
vii Once TCP/IP has been installed, repeat steps 1 to 4.

5 Check TCP/IP properties:

i Click Properties.
The Internet Protocol (TCP/IP) Properties window opens to the 
General tab.

ii Make sure the Obtain an IP address automatically radio 
button is enabled.

iii Make sure the Obtain DNS server address automatically 
radio button is enabled.

iv Click OK on the Internet Protocol (TCP/IP) Properties window.
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v Click OK on the Local Area Connection Properties window.
vi Click Close on the Local Area Connection Status window.
vii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on 
the computer connected to the indoor unit.

If your browser automatically opens to your service provider’s 
Web site, full service has been activated.

If your browser does not automatically open to your service 
provider’s Web site, go to step 6.

7 Enter a valid Internet address (such as www.google.com) in the 
Address field and press Enter.

If the Web page opens, full service has already been activated 
and you can begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service 
by following the sign-up procedure that is provided on the Web 
site.

If your computer attempts an Internet connection using an old 
dial-up connection, see "The Computer Uses an Old Dial-Up 
Connection" on page 46.

If you do not get an Internet connection, see "Finding Causes 
of Computer Problems" on page 36.

To change network settings in Mac OS 8 and 9
NOTE: Your computer must have an Ethernet card and Open 
Transport networking software to connect to the Internet.

1 Click the Apple icon and choose Control Panels > TCP/IP.

The TCP/IP window opens.

2 Select Ethernet from the Connect via pop-up menu.

3 Select Using DHCP Server from the Configure pop-up menu.

4 Close the TCP/IP control panel.

If you made any changes, save them when prompted.

5 Restart your computer.

6 Check your Internet connection by launching a Web browser on 
the computer connected to the indoor unit.
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If your browser automatically opens to your service provider’s 
Web site, full service has already been activated.

If your browser does not automatically open to your service 
provider’s Web site, go to step 7.

7 Enter a valid Internet address (such as www. google.com) in the 
Address field.

If the Web page opens, full service has already been activated 
and you can begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service 
by following the sign-up procedure that is provided on the Web 
site.

If you do not establish an Internet connection, see "Finding 
Causes of Computer Problems" on page 36.

To change network settings in Mac OS X
1 Click the Apple icon and choose System Preferences.

2 Choose View → Network.

3 Choose Built-in Ethernet from the Show pop-up menu.

4 Click the TCP/IP tab, if necessary.

5 Choose Using DHCP from the Configure pop-up menu.

6 Click Apply Now.

7 Restart your computer.

8 Check your Internet connection by launching a Web browser on 
the computer connected to the indoor unit.

If your browser automatically opens to your service provider’s 
Web site, full service has already been activated.

If your browser does not automatically open to your service 
provider’s Web site, go to step 6.

9 Enter a valid Internet address (such as www.google.com) in the 
Address field and press Enter.

If the Web page opens, full service has already been activated 
and you can begin using your SOMAport for Internet service.
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If your service provider’s Web page opens, activate full service 
by following the sign-up procedure that is provided on the Web 
site.

If you do not establish an Internet connection, see "Finding 
Causes of Computer Problems" on page 36.
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IP ADDRESS NEEDS
TO BE RENEWED

If you cannot connect to the Internet even after you have checked all cabling and 
network settings and have rebooted the computer, follow the appropriate procedure 
in this section to manually obtain a new IP address.

To obtain a new IP address (Windows 95 only)
1 Choose Start → Run.

2 Enter winipcfg in the Open field and click OK.

The IP Configuration window opens.

3 Select the network interface that has a default gateway of 
192.168.1.1 from the pull-down list.

4 Click Release All.

5 Force your computer to obtain a new IP address by clicking 
Renew All.

Wait until the fields in the IP Configuration window have values in 
them or an error message appears. If you close this program 
before it has completed its task, you will have to reboot your 
computer before you can use your Internet service.

6 Close the IP Configuration window.

To obtain a new IP address (all other versions of Windows)
1 Open a command window using one of the following methods:

In Windows 2000 or XP, choose

Start → Programs → Accessories → Command Prompt.
In Windows 98 or ME, choose Start → Programs → MS-
DOS Prompt.

The command window opens.
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2 Force your computer to obtain a new IP address by typing the 
appropriate command from the following table:

The Windows IP configuration is displayed.

3 Look for the output section related to the network interface for the 
SOMAport. 

Example:

Ethernet adapter:
IP address............. : 65.94.64.233
Subnet Mask............ : 255.255.255.0
Default Gateway........ : 192.168.1.1

4 Close the MS-DOS Prompt or Command Prompt window.

Operating System Command

Windows 98 or ME ipconfig /renew_all ↵

Windows 2000 or XP ipconfig /renew ↵
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SPECIFICATIONS

Release Outdoor SOMAport R3.0

Internal antenna Type: internal passive-steered array antenna
Internal antenna gain: 4.5 dBi
Reciever noise figure: 6 dB
Transmitted EIRP: 31.5 dBm
RF output power: 27 dBm

Device ports and 
Interfaces

Telephone
Telephone terminal interface (RJ-11 jacks) (2)
Data
Data terminal interface (RJ-45 Ethernet 10Base-T)
AC Adapter
AC Adapter (Coaxial DC Power Jack, 30AV/2A)
Between Outdoor Unit and Indoor Unit
CAT-5 Ethernet w/Power feed and two telephone lines

Lights
(Indoor Unit)

Power, Network

Power 
Requirements

Power Supply
Type: U.S./International 100/240V AC-DC external power supply
Cable: Power cord with non-wall-mounted AC-to-DC transformer

Environmental 
Specifications 
(Outdoor Unit)

Temperature 
Operating: 5°C to 40°C (+46°F to +104°F) (w/o Heater)
Humidity
Operating: 0% to 85%, noncondensing
Altitude
Operating: 2438 m (8000 feet)
Water Proof
IP25

Packaging Dimensions
Outdoor Unit
Height: 18.5 cm (7.3 inches)
Width: 21 cm (8.3 inches)
Depth: 21 cm (8.3 inches)
Weight: 3 kg (6.7 pounds)
Volume: 8000 cc

Indoor Unit
4.6 cm (1.8 inches)
10.4 cm (4.1 inches)
8.4 cm (3.3 inches)
0.3 kg (0.7 pounds)
400 cc

Regulatory 
Certifications

IEC 61000-4-5 class 3
CE
CB Scheme (IEC60950-1)
FCC Part 15B, Part 24 (PCS Only)
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OUTDOOR SOMAPORT
INSTALLATION GUIDE

Part 006217 revision 01

WARNING: The installation procedures described in this 
chapter are intended only for qualified technicians. Non-
qualified personnel should not perform this installation.
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